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RESUMEN 

 

Se presenta una metodología para la modelación hidrológica de una cuenca del estado de 

Guerrero, como parte de su estudio hidrológico, para la reproducción sistemática del 

comportamiento de la cuenca ante la ocurrencia de lluvias que puedan provocar 

inundaciones de gran magnitud, mediante la obtención de parámetros, con ayuda del 

software HEC-GeoHMS y Sistemas de Información Geográfica (SIG).La obtención de 

características y parámetros  hidrológicos, es de suma importancia para el cálculo y diseño 

de obras hidráulicas aplicadas a las vías terrestres, la correcta determinación de éstos 

repercute significativamente en los resultados del estudio hidrológico y por ello en el 

dimensionamiento de puentes, alcantarillas, vados, etc. Las etapas del estudio hidrológico de 

una cuenca, para el diseño de obras hidráulicas son: Información básica, pre-procesamiento 

de la información, análisis de la precipitación y características del escurrimiento. 

 

Lo que se pretende con el uso de HEC-GeoHMS es obtener las características físicas de una 

cuenca hidrográfica para luego estimar los parámetros hidrológicos, que serán los datos de 

entrada para HEC-HMS.  El esquema de trabajo en HEC-GeoHMS es el siguiente: 

 

• Pre-proceso del terreno  

• Extracción de la cuenca de estudio  

• Procesado de la cuenca  

• Obtención de la características de cauces y subcuencas  

• Estimación de los parámetros hidrológicos  

• Exportar datos a HEC-HMS  

 

El algoritmo de cálculo implementado en HEC-GeoHMS se basa en la premisa de  que el 

agua fluye siguiendo la línea de máxima pendiente. Por lo tanto, en un MDE en formato 

Raster, el agua que haya en una celda fluirá hacia una de las ochos celdas que la rodean, 

siguiendo la línea de máxima pendiente. Este algoritmo se conoce como algoritmo de flujo en 

ocho direcciones. 
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I. INTRODUCCIÓN 

 

La modelación hidrológica es una herramienta muy importante para la elaboración 

del estudio hidrológico y sus características. Actualmente, con el empleo de la 

modelación, se realiza el análisis y la prevención de las inundaciones; además, es 

posible manejar hipótesis más realistas o previsibles que ofrezcan un mayor grado 

de confianza para la toma de decisiones, ya sea en la ordenación del territorio en 

torno a los ríos o para exigir criterios de diseño de obras e infraestructuras capaces 

de soportar y funcionar adecuadamente en situaciones de emergencia. 

 

Sin embargo, al llevar a cabo una modelación se va complicando debido a la 

carencia de datos, como lo intensidad de lluvia, altura de lámina de lluvia, duración 

de las precipitación, periodos de retorno, ya que las estaciones con las que cuenta 

actualmente la república, no registran algunos datos, por diferentes circunstancias, 

como lo son por mantenimiento de las mismas, mal manejo de la información, 

carencia de personal que atiendan las estaciones. 

 

Por esta razón un estudio hidrológico elaborado sin ayuda de programas informáticos 

se va complicando, sin embargo al hacer uso de ayuda, como lo es un software dicho 

estudio se desarrolla con mayor facilidad. Hay una gran variedad de programas que 

existen para llevar a cabo un análisis hidrológico por medio de la modelación, siendo 

el Sistema de Modelación Hidrológico del Centro de Ingeniería Hidrológica del 

Cuerpo de Ingenieros del Ejército de los EE. UU. (HEC-HMS por sus siglas en inglés) 

el aplicado en la presente investigación ya que es un programa computacional 

gratuito, el cual provee una variedad de opciones para simular procesos de 

precipitación escurrimiento y tránsito de caudales. Este modelo utiliza métodos de 

precipitación-escorrentía para estimar los hidrogramas de escorrentía directa 

generados por las precipitaciones en una cuenca o región durante un período 

especificado. Es un programa muy flexible que permite al usuario la selección de 

diferentes métodos para el cálculo de pérdidas, hidrogramas, flujo base y 

propagación en cauces. 
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I.1. Justificación 

 

Actualmente  la facultad de ingeniería de la Universidad Autónoma de Querétaro 

carece de un manual para el Software ArcGIS y HEC-HMS, por lo que se hace 

necesario contar con un documento en el que se explique las herramientas básicas y 

las formas de uso de estos programas que son de gran utilidad y ampliamente 

utilizados en la elaboración de estudios hidrológicos en el país. 

 

 

I.2. Objetivo 

 

El principal objetivo es realizar un manual de uso de dos de los diferentes programas 

informáticos empleados para llevar a cabo una modelación de una cuenca 

hidrográfica, dichos programas fueron usados durante el curso de actualización, 

mediante un recopilación de los diferente manuales ya existentes, así como también 

de diferentes trabajos elaborados para el análisis hidrológico de cuencas de 

diferentes zonas. En este trabajo se toma en cuenta las diferentes normativas de la 

Secretaría de Comunicaciones y Transporte, especialmente la normativa para el 

diseño de obras hidráulicas para puentes y la normativa para el estudio hidrológico.  
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II. REVISIÓN DE LITERATURA 

 

Para tener un mejor conocimiento de las herramientas, así como de los procesos que 

se llevan a cabo en la modelación, fue necesario una investigación y revisión de 

literatura previa, para esto se buscaron artículos de trabajos elaborados con el uso 

de estos programas, así como también de algunos manuales existentes, para 

conocer las herramientas y la función que tienen en el proceso de modelación, así 

como los pasos y procesos necesarios. 

 

Otro medio de información consultado fue la normativa que tiene la Secretaría de 

Comunicaciones y Transporte (SCT), que deben ser tomadas en cuenta en la 

realización de los proyectos de diseño de vías terrestres. En estas normas se 

encuentran las relacionadas con los estudios hidráulicos e hidrológicos necesarios 

para el diseño y construcción de obras hidráulicas. 

 

II.1 Antecedentes 

 

Especialistas cubanos en los últimos años han dado pasos en la aplicación del HEC-

HMS para obtener hidrogramas de avenidas en algunas zonas del país, pero la 

experiencia de aplicación alcanzada es todavía insuficiente. En este sentido la 

presente investigación realiza recomendaciones para la modelación con HEC-HMS 

en cuencas montañosas de la región oriental de Cuba a partir de su aplicación en la 

cuenca Las Coloradas, obteniendo experiencias en los métodos de cálculo de mejor 

aplicación y los valores que alcanzan sus parámetros. Se han tenido en cuenta las 

particularidades físico-geográficas y climáticas de las cuencas montañosas orientales 

y el estado de la información hidrometeorológica en las mismas. (Estrada, 2012). 

 

El problema de carencia o escases de hidrogramas, lo compensaron con las 

herramientas que trae el programa para llevar a cabo la elaboración de los mismos 

con ayuda de datos de medición de lluvia media diaria, tomada de estaciones 

cercanas a la cuenca de estudio. 
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Sin embargo existen problemas mayores que la carencia de datos como hidrogramas 

o hietogramas, en algunos casos no se cuentan con datos o parámetros de lluvia, 

debido a los escases o inexistencia de estaciones cercanas, para este problema se 

pueden estimar o hacer predicciones de dichos parámetros, con datos medidos en 

estaciones cercanas a la zona de estudio. 

 

El escurrimiento es una de las variables hidrológicas más importantes que se emplea 

en la mayoría de los usos de los recursos de agua. La obtención de una predicción 

confiable del escurrimiento superficial hacia corrientes y ríos en cuencas sin datos de 

aforo es un proceso difícil que consume mucho tiempo. Sin embargo, las tecnologías 

de percepción remota y los Sistemas de Información Geográfica (SIG) pueden 

complementar en gran medida a los métodos convencionales en estudios de lluvia-

escurrimiento. Estas técnicas pueden ser aplicadas para estimar la variación espacial 

de los parámetros hidrológicos que se emplean en modelos de lluvia-escurrimientos. 

(Hammouri, 2007). 

 

Para evitar problemas de inundaciones durante las temporadas de lluvia es 

importante llevar a cabo previamente un análisis hidrológico, en el cual las 

mediciones se elaboran en escalas pequeñas de tiempo para aumentar la eficiencia 

del mismo, sin embargo estos tipos de análisis se dificultan debido a la carencia de 

datos en este tipo de mediciones. 

 

Resulta muy importante en los estudios de este tipo, sobre todo cuando no existen 

suficientes datos para calibrar el modelo hidrológico, contar con un análisis de los 

resultados de varias simulaciones de eventos que puedan producirse en la zona para 

conocer las características generales de las respuestas de la cuenca ante dichos 

eventos, y así poder tomar decisiones, partiendo de la información de la lluvia que 

esté cayendo en la región en un momento dado. (Rodríguez, 2010). 
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La problemática asociada a las avenidas y las inundaciones que provocan es 

compleja, ya que intervienen numerosos factores entre los cuales se encuentran la 

magnitud y localización de las poblaciones, las obras y la actividad antropogénica en 

las zonas estudiadas, las características fisiográficas de la cuenca incluyendo su 

sistema fluvial. 

 

Los modelos de transformación lluvia – escurrimiento son una herramienta muy útil 

en la previsión de las avenidas. Contar con ellos en nuestros países es necesario, ya 

que se ven afectados con frecuencia por lluvias intensas, que provocan inundaciones 

en intervalos de tiempo relativamente cortos, las que traen consigo muchos daños 

sociales y económicos. El modelo obtenido brinda la posibilidad de realizar 

predicciones de los valores de los gastos máximos a producirse así como los 

hidrogramas en diferentes puntos de la cuenca, luego de conocer el pronóstico de 

lluvias en una zona determinada. Los resultados de tales simulaciones posibilitan 

tomar medidas preventivas para salvaguardar tanto vidas humanas, como bienes de 

los sectores económicos que se afectarán. (Gil, 2010). 

 

Una de las aplicaciones frecuentes en el manejo de recursos hídricos tiene que ver 

con la producción de mapas de inundaciones a partir de registros puntuales de 

precipitación, utilizando de forma acoplada las herramientas de modelación 

hidrológica HEC-GeoHMS y HEC-HMS, y las herramientas de modelación hidráulica 

HEC-GeoRAS y HEC-RAS, del Cuerpo de Ingenieros delos Estados Unidos. Para la 

calibración del modelo hidrológico HEC-HMS se utilizan tormentas registradas, y 

tormentas sintéticas para la generación de eventos torrenciales, que son analizados 

hidráulicamente utilizando la aplicación de flujo no permanente del modelo HECRAS. 

Los resultados obtenidos permiten concluir que el uso adecuado, sistemático y 

responsable de herramientas de procesamiento de información geográfica, 

combinadas con la aplicación de modelos hidrológicos e hidráulicos, correctamente 

calibrados y validados, brinda a los tomadores de decisiones información valiosa y 

oportuna para la implementación de medidas que tiendan a reducir el impacto de 

eventos torrenciales y catastróficos sobre la población. (Rodríguez, 2007). 
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II. 2 Normatividad de la Secretaría de Comunicaciones y Transportes (SCT) 

 

El primer libro de las normativas consultado, es el manual del libro PRY PRYECTO, 

de tema Carreteras, parte 1 Estudios, con título Estudios Hidráulico – Hidrológicos 

para puentes, conformado por varios capítulos, de los cuales los utilizados son el 

capítulo III, IV, y V. 

 

El capítulo III contiene los procedimientos para procesa la información necesaria, 

disponible, también aquella que se pueda obtener de un reconocimiento previo en 

campo, así como también de los levantamientos topográficos que se puedan realizar. 

El primer proceso referenciado en el manual es la determinación de las 

características de la cuenca, entre las características a determinar están el área de la 

cuenca, pendiente media y longitud del cauce principal, coeficiente de escurrimiento, 

pendientes medias del cauce principal, coeficiente de rugosidad. 

 

Una vez determinadas éstas características sigue los procedimientos para la 

determinación de las características hidrológicas: como lo son: características de la 

precipitación a partir de los siguientes métodos: a partir de isoyetas, a partir de datos 

obtenidos de las estaciones pluviográficas, y de datos obtenidos en estaciones 

pluviométricas, así como también características del escurrimiento. 

 

El siguiente capítulo (capítulo IV) contiene los procedimientos empleados para los 

análisis hidrológicos y para determinar los gastos que se utilizarán en el diseño 

hidráulico del puente de acuerdo con los períodos de retorno establecidos en dicho 

manual. 

 

II.3 Conceptos hidrológicos básicos  

 

Un hidrograma de escurrimiento es un registro continuo del flujo en un cauce a través 

del tiempo (Haan, 1994). En el manejo de agua de tormenta, es de interés el 
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hidrograma de escurrimiento a la salida de la cuenca y algunos puntos dentro de la 

misma, además que al analizar hidrogramas es posible determinar la disponibilidad 

efectiva de agua y su distribución temporal en condiciones naturales. (Quevedo, 

2013). 

 

En general, el hidrograma es el resultado de un hietograma de precipitación efectiva, 

es decir, la precipitación total   menos las pérdidas (por infiltración, retención, 

evaporación, etc.). Esto lleva a que el volumen de agua definido por el “área bajo la 

curva” de un hietograma de lluvia efectiva sea igual al volumen de escurrimiento 

directo. 

 

 

 

Figura 1. Terminología de hidrogramas 

 

Las áreas bajo la curva definidas por el hidrograma y el hietograma representan el 

mismo volumen D  de agua. Obviamente, en el gráfico anterior se han utilizado 

escalas diferentes para la precipitación y el escurrimiento. El máximo registro en el 

hidrograma es el gasto pico PQ ; y el tiempo desde el inicio del hidrograma hasta 
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dicho valor se conoce como tiempo pico PT . La duración total del hidrograma de 

escorrentía directa es el llamado tiempo base bT . 

 

Por su parte, el tiempo de concentración cT , se define como el lapso que tarda el 

escurrimiento de una tormenta en viajar desde el punto más distante hasta la salida 

de la cuenca o sitio de proyecto, o bien el lapso transcurrido desde el final de la 

tormenta hasta el término del hidrograma superficial. En cambio, el tiempo de 

retraso, LT ,es el tiempo medido entre el llamado centro de masa de la precipitación 

efectiva y el pico del hidrograma de escurrimiento. 

 

Las pérdidas de lluvia por el método del SCS es un planteamiento semiempírico, 

propuesto por el Servicio de Conservación de Suelos de los Estados Unidos (SCS, 

1972, 1980) para estimar la precipitación en exceso que produce la escorrentía. Se 

trata de una técnica que determina la cantidad total de agua que escurre, después de 

restar “las pérdidas”, pero sin evaluar su variabilidad temporal. Se le conoce también 

como: método de la curva CN, método SCS o método de las abstracciones. El SCS 

ha propuesto valores de   tabulados en función del tipo y uso del suelo, de modo que 

para cuencas heterogéneas se puede calcular un valor compuesto (ponderado). El 

método contempla una corrección de CN, según las condiciones antecedentes de 

humedad (CAH). 

 

El método de Muskingum es un procedimiento de tránsito hidrológico que se emplea 

para manejar relaciones variables de caudal-almacenamiento. Este método modela 

la regulación volumétrica de una creciente en un tramo de río mediante la geometría 

de una cuña y un prisma. Durante el avance de la onda creciente, el caudal de 

entrada es mayor que el de salida y corresponde a un almacenamiento de cuña. 

Durante la recesión, el caudal de salida es mayor al de entrada, a manera de cuña 

negativa. Adicionalmente, existe un almacenamiento definido por el tramo de río, 

supuesto canal prismático, de longitud y sección transversal constante con respecto 

a la distancia. 
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II.4 Herramientas computacionales 

 

ArcGIS es un “software” de Sistema de Información Geográfica diseñado por la 

empresa californiana Enviromental Systems Research Institute (ESRI) para trabajar a 

nivel multiusuario. Está compuesto por dos aplicaciones diferentes: 

 

 ArcMap 10. Permite realizar mapas a partir de capas o datos espaciales, elegir 

colores y simbología, interrogar a las bases de datos, analizar relaciones 

espaciales y diseñar mapas o salidas impresas. La interfaz de ArcMap se 

compone de una tabla de contenidos donde se listan todas las capas que 

forman el mapa, una ventana donde se muestra el mapa, y una serie de 

menús y herramientas para trabajar con las capas y mapas (Puerta, 2011). 

 

 ArcCatalog. Es la aplicación que se utiliza para gestionar los archivos a 

utilizar: mapas, bases de datos etc. Ayuda a organizar la información 

geográfica y es imprescindible para mantener nuestros datos en orden. 

 

 ArcToolBox: Sirve para realizar operaciones de procesamiento de información 

geográfica: análisis de datos espaciales, conversión de formatos, gestión de 

datos y muchas más operaciones. 

 

El sistema permite separar la información en diferentes “capas” (Layers) temáticas y 

las almacena independientemente, permitiendo trabajar con ellas de manera rápida y 

sencilla, y facilitando al profesional la posibilidad de relacionar la información 

existente a través de la topología de los objetos, con el fin de generar otra nueva que 

no podríamos obtener de otra forma. 
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Existen dos formas de almacenar los datos en un SIG: Raster y vectorial. 

 

 RASTER: Cualquier tipo de imagen digital representada en mallas. Divide el 

espacio en celdas regulares donde cada una de ellas representa un único 

valor. 

 

 VECTORIAL: Aquí los datos están basados en la representación vectorial de 

la componente espacial de los datos geográficos. Esta forma de expresión 

espacial implica la utilización de los tres tipos de elementos espaciales, de 

carácter geométrico, en que pueden ser interpretados los objetos geográficos: 

puntos, líneas y polígonos. 

 

La interfaz de ArcMap se compone de dos partes principales: una, a la derecha, para 

mostrar la información espacial llamada área de visualización (Map Display), y otra, a 

la izquierda, que consiste en una tabla de contenidos (Table Of Contents, TOC) 

donde se listan las capas que se muestran. Además, la interfaz contiene una serie de 

menús y barras de herramientas (Draw, Standard y Tools) para trabajar con los 

datos. (Puerta, 2011). 

 

 



  
16 

 
  

Figura 2. Ventana con las diferentes partes del programa Arc Map 10 

 

 

Figura3. Diferentes propiedades y características de las capas 
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III. METODOLOGÍA 

 

III.1.Información requerida 

 

 III.1.1 Zona de estudio 

 

Platanillo se localiza en el Municipio Técpan de Galeana del Estado de Guerrero 

México y se encuentra en las coordenadas GPS: Latitud: 17° 30’ 35.76’’. Longitud: 

100° 34’ 47.27’’. Este municipio pertenece a la región de la Costa Grande; se ubica al 

suroeste de Chilpancingo, entre las coordenadas 17° 06’ 57’’ y 17° 41’ 33’’ de latitud 

norte y los 100° 27’ 11’’ y 101° 04’ 59’’ de longitud oeste. Cuenta con una extensión 

territorial de 2320 km2, que representa el 3.64% con relación al total estatal. Limita al 

norte con Ajuchitlán y Coyuca de Catalán, al sur con el océano Pacífico, al este con 

Atoyac, San Miguel Totolapan y Benito Juárez, y al oeste con Petatlán. 

 

Los tipos de suelo localizados en zonas planas son los aluviales o de acarreo; 

presentan color café grisáceo o café rojizo y amarillo bosque; chernozem o negro; y 

estepa praire o pradera con descalcificación. En la parte media y alta de la montaña 

aparecen los suelos de color variado, gris amarillo, crema rojizo, etcétera, con textura 

de migajón arenoso y arenoso con grava. Todos ellos, aptos para la agricultura y 

ganadería. 

 

La conforman tres tipos de relieve: las zonas accidentadas están presentes en un 

74% del territorio, localizadas en la Sierra Madre del Sur, las cuales están cubiertas 

por bosques forestales; las zonas semiplanas abarcan el 11% de la superficie, 

localizadas en la parte donde se inicia la montaña, formadas por lomeríos con 

pequeñas áreas cultivables; las zonas planas abarcan un 15% de la superficie 

municipal. Entre los ríos más importantes que recorren el municipio figuran: Tecpan, 

Nuxco, Zihuatlán, Grande o San Luis; se localizan también las lagunas de Nuxco y El 

Plan. 
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En la parte alta presenta un clima semicálido subhúmedo; mientras que en la parte 

baja, un clima cálido subhúmedo. La temperatura promedio anual es de 26 °C. Tiene 

una precipitación anual promedio de 1050 mm. 

 

 

 

Figura 4. Ubicación del punto de estudio de acuerdo a la región hidrológica 

correspondiente 

 

 

 

Figura 5. Localización del municipio de Técpan en el estado de Guerrero 
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Antes de iniciar con el proceso de modelación, para llevar a cabo el análisis 

hidrológico, para el diseño de obras hidráulicas en una vía terrestre, es necesario 

recabar información que se podría considerar como básica, la cual consta de cartas 

topográficas, cartas de tipo y uso de suelo, así como también cartas de vegetación 

existente en la zona de estudio. 

 

 III.1.2 Topografía 

 

Como se mencionó en el párrafo anterior se necesita la carta topográfica de la zona 

de estudio, para mejor efecto se consiguió un Modelo Digital de Elevaciones (DEM, 

por sus siglas en inglés Digital Elevation Model) el cual contiene información 

suficiente, como su nombre lo dice contiene las elevaciones del terreno, para definir 

las propiedades de la red de drenaje superficial y de la cuenca hidrológica, además 

la zona de estudio debe de estar contenida en dicho modelo. El modelo antes 

mencionado se descargo del sitio web de INEGI (Instituto Nacional de Estadística y 

Geografía) con la siguiente dirección electrónica 

http://www.inegi.org.mx/geo/contenidos/datosrelieve/continental/Descarga.aspx 

 

Para el caso de estudio se descargó el DEM del estado de Guerrero, por lo que en la 

página antes mencionada, en la pestaña seleccionar la entidad federativa se 

colocará la opción de Guerrero, en resolución se dejará la opción que nos marca, la 

de 15 metros. 

 

 

http://www.inegi.org.mx/geo/contenidos/datosrelieve/continental/Descarga.aspx
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Figura6. Ventana de la página de INEGI, donde se pueden descargar los modelos 

digitales de elevación 

 

Una vez descargado el archivo se crea una carpeta identificable y que contendrá 

únicamente los archivos que se utilizarán en este ejercicio, por ejemplo en la carpeta 

C:/Puente; una vez creada la carpeta se extrae el contenido del archivo descargado 

anteriormente, ya que el archivo descargado se encontrara en un formato 

comprimido. 

 

Otra parte importante considerada también como información básica son las cartas 

de tipos y uso de suelo, al igual que la carta topográfica se cambiarán dichas cartas 

por un Modelo Digital, el cual contendrá la información necesaria de toda la 

república, como lo es el tipo de suelo con el cual se conforma, así como el uso de 

suelo que se le puede dar al tipo de suelo marcado, y un modelo edafológico. 

 

El siguiente paso es la obtención de las coordenadas geográficas, primeramente las 

coordenadas que ubican la zona de estudio, así como también las coordenadas de 

cierre o bien del punto de salida del cauce principal de la cuenca, las cuales son las 

siguientes para el caso de estudio: 
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Tabla 1. Coordenadas del punto de salida de la cuenca platanillo 

 

X Y 

332, 284.98 1’ 936, 663.68 

 

Tabla 2. Coordenadas usadas para la limitación del polígono de estudio 

 

 X Y 

Inicial 327, 000 1’ 947, 000 

Fina 335, 000 1’ 935, 000 

 

Las coordenadas mostradas en las tablas anteriores se encuentran en coordenadas 

UTM (Universal Transversal de Mercator), pero debido a que el primer programa a 

emplear usa coordenadas geodésicas para la delimitación de la zona del Modelo 

Digital de Elevaciones (DEM), es necesario la conversión de dichas coordenadas al 

sistema antes mencionado, en éste las coordenadas se expresan en latitud, es la 

distancia del meridiano medido en grados, minutos y segundos desde el Ecuador a 

cualquier punto en la tierra, se mide en dirección Norte o Sur, y longitud, es la 

distancia del paralelo medido en grados, minutos y segundos desde el Meridiano de 

Greenwich a cualquier punto de la tierra, se mide en dirección Este u Oeste a partir 

de dicho meridiano. 

 

La conversión de coordenadas antes mencionado, se llevó  cabo gracias al software 

TMCALC del INEGI, el cuál es un software usado para la conversión de coordenadas 

a cualquiera de los 4 sistemas. 
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Figura7. Software TMCALC usado para la conversión de coordenadas 

 

En la tabla siguiente se muestran las coordenadas convertidas en coordenadas 

geodésicas necesarias para la delimitación del polígono de estudio. 

 

Tabla 3. Coordenadas  geodésicas usadas para la limitación del polígono de estudio 

 

 Latitud Ø Longitud λ 

Inicial 17° 36’ 10.526’’ 100° 37’ 49.447’’ 

Final 17° 29’ 42.371’’ 100° 33’ 14.773’’ 

 

III.2 Procesamiento de los modelos de elevación con ArcGIS 10 

 

Para añadir una capa en ArcMap se utiliza el botón Add Data, al que se accede 

también desde el menú de la barra de herramientas standard: File>Add data y desde 

el menú contextual del Data frame. Si es la primera vez que se utiliza el software, es 

necesario conectar los folder donde se encuentre todos los archivos de la 

información básica previamente obtenidos, por esta razón se creó una carpeta en el 

disco duro en la cual se guardaron todos los archivos antes mencionados. 
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Para este proceso se le da clic en el botón de “connect to folder” en la ventana que 

se abre al dar clic en “add data”. Posteriormente se abrirá una nueva ventana en la 

que se nos pide buscar la carpeta deseada para conectar, en este caso se busca la 

carpeta Puente en la dirección C:\Puente, por último una vez localizado el folder se 

da clic en el botón de aceptar. 

 

 

 

Figura8.Icono de “Connect to Folder” 

 

 

 

Figura9. Ventana de “Connect to Folder” para seleccionar el folder correspondiente 

 

Una vez conectado el folder donde se encuentra el Modelo Digital de elevaciones así 

con la información básica recopilada previamente, se abre la carpeta de “Guerrero” 

que se encuentra dentro de la carpeta “Puente”, ya que el DEM se encuentra en esta 

subcarpeta, se abre el archivo “Guerrero30_R15m.bil”. Posteriormente se generará 

un mensaje en una ventana al cual se le da “Yes”. 
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Figura10. Ventana de Add data 

 

 

 

Figura11. Creación del mapa del MDE 

 

 

 

 

Figura 12. Mapa del MDE con elevaciones del estado de Guerrero 
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De esta manera se abrirá la capa del modelo digital de elevaciones del estado de 

Guerrero, por lo tanto el paso siguiente es delimitar la zona de estudio, es decir 

recortar el modelo digital abierto, con la ayuda de las coordenadas previamente 

calculadas, para obtener de esta forma el polígono de la zona de estudio. 

Para este paso se le da clic en el botón “Arc ToolBox Window” en la barra de 

herramientas, de esta manera se abrirá una ventana de herramientas diferente, 

seleccionamosData Management Tools > Raster > Raster Processing > Clip. 

 

 

 

Figura13. Ventana con la herramienta clip del Arc ToolBox Window 

Se abrirá una ventana de diálogo en el recuadro de Raster de la ventana se 

selecciona el archivo de Guerrero, en los recuadros de rectangle se introducen las 

coordenadas geodésicas en decimales, en el recuadro de output, se busca la 

siguiente dirección de la carpeta C:\Puente\Guerrero, y se le pone el nombre de 

platanillo. 
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Figura 14. Ventana de la herramienta Clip 

 

Para visualizarlo se apaga la capa de nombre “Guerrero30_R15m.bil” dando un clic 

en el cuadro que contiene una “palomita”, posteriormente damos clic derecho en la 

capa “platanillo” y seleccionamos la opción “Zoom toLayer”. 

 

 

 

Figura 15. “Zoom to Layer” y capa de Guerrero apagada 

Posteriormente es necesario cambiar el sistema de coordenadas, para tener un 

mejor manejo del modelo. Para cambiar el Modelo Digital de Elevaciones(MDE) de 

coordenadas geográficas a UTM (“Universal Transversa de Mercator”), en el 

“ArcToolboxwindow”se selecciona la opción Data Management Tools > Projections 

and Transformations > Raster > Project Raster. 
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Figura 16. Ventana con la herramienta Project Raster del Arc ToolBox Window 

 

Después del paso anterior se desplegará una nueva ventana de diálogo, en la que en 

la opción “input Raster” se selecciona el archivo platanillo (ya que es el MDE que 

contiene el polígono de estudio ya delimitado), en la parte de “output Raster dataset” 

se busca la carpeta C:\Puente\Guerrero y teclear el nombre de “platanilloUTM” en el 

campo “Name:” En la siguiente opción “output coordinate system” se le da clic en el 

botón que se encuentra a la derecha del campo, para buscar el sistema de 

coordenadas deseadas. 
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Figura 17. Ventana de la herramienta Project Raster 

 

Se abrirá una nueva ventana, en la que se selecciona la opción “select”, se abrirá 

una nueva ventana en la que contiene las carpetas en donde se encuentran los 

archivos con los diferentes tipos de coordenadas, de ahí se sigue la siguiente ruta 

para llegar a las coordenadas UTM, Projected Coordinate Systems > UTM > WGS 

1984 > Northern Hemisphere > WGS 1984 UTM Zone 14N.prj. Se da clic “Add” y 

después “OK”. 

 

 

 

Figura 18. Ventana de búsqueda de las coordenadas UTM 
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Figura 19. Ventana de selección de las coordenadas UTM 

 

Al llevar a cabo este paso regresa a la ventana de “Project Raster”, en ésta en el 

campo de “geographic trensformation” se seleccionaprimero  la opción 

ITRF_1992_ToITRF_2000_1 y después ITRF_2000_To_ WGS_1984. 

Posteriormente de esto se le da clic en “ok”, de esta manera se termina de cambiar 

las coordenadas de geodésicas a UTM, creando un nuevo modelo o mejor dicho una 

nueva capa, con el nombre de “platanilloUTM”. 

 

 

 

Figura 20. Ventana de Project Raster con las coordenadas a cambiar 

Con este paso se comenzará a utilizar las herramientas de HEC- GeoHMS, que no 

son más que una barra de herramientas complementarias en el software de Arc MAP 

10. 

 

Para un mejor manejo del programa y una mejor modelación, al tener las tres capas, 

es necesario iniciar un nuevo archivo de mapa, sin embargo no se guardan los 

cambios, al abrir un archivo nuevo, se carga únicamente el MDE con el nombre de 

“platanilloUTM”, ya que es el modelo con el polígono delimitado y con las 

coordenadas UTM, con esta capa cargada en el archivo nuevo se procede a iniciar el 

proyecto, para esto es necesario guardarlo, en File > Save, o bien desde el menú o la 

barra estándar, en la carpeta C:\Puente, con el nombre de Proyecto. 



  
30 

 
  

III.3. Procesamiento del terreno 

 

III.3.1 Relleno de depresiones 

 

Para llevar a cabo con el proyecto de modelación para el análisis hidrológico de la 

zona de estudio, es necesario que el modelo de elevaciones a trabajar debe de no 

presentar depresiones en el terreno, para esto es necesario previamente a empezar 

el proyecto rellenar las depresiones que se presenten en el MDE, es decir es 

necesario aumentar las cotas de las celdas que se encuentran rodeadas por celdas 

con cotas mayores, De esta manera el agua podrá fluir libremente a través de las 

diferentes celdas sin que ésta se estanque. 

 

Para llevar a cabo el proceso de rellenó o bien del aumento de las cotas menores se 

sigue el siguiente proceso. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Fill Sinks. Una vez hecho esto se abrirá una ventana, en ésta únicamente se tiene 

que seleccionar la capa deseada a rellenar, para el caso de estudio es la capa 

cargada la de “platanilloUTM” y se le da clic en “OK”. Cuando el programa haya 

terminado de elaborar el proceso de relleno del terreno, aparecerá una ventana con 

el texto de “completed” a la que se le da clic en “close”, y nos mostrará una nueva 

capa con el nombre de “fil”. 
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Figura21. Ventana de opciones de la herramienta Fill Sinks 

 

Una vez terminado el proceso de relleno de depresiones en el MED, se inicia el 

proceso del análisis hidrológico de la zona de estudio, a partir de aquí se usa la capa 

del modelo sin depresiones, y en cada nuevo proceso se utiliza la capa de la salida 

de cada paso. 

 

III.3.2. Dirección del flujo 

 

En este primer paso como su nombre lo indica se lleva un análisis para observar la 

dirección del flujo de agua que se presenta, para esto en este primer paso se define 

la dirección de la mayor pendiente, el programa lo realiza evaluando las diferentes 

cotas de cada una de las celdas que lo rodean. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Flow Diretion. Una vez hecho esto se abrirá una ventana, en ésta únicamente se 

tiene que corroborar que los datos sean los correctos, es decir que en la opción de 

“input hydro DEM” se encuentre el archivo de fil previamente elaborado y que en la 

opción de “output flow direction grid” e encuentre la carpeta de C:\puente\Layers\Fdr 

y se le da clic en “OK”. Cuando el programa haya terminado de elaborar el proceso 

de relleno del terreno, aparecerá una ventana con el texto de “completed” a la que se 

le da clic en “close”, y nos mostrará una nueva capa con el nombre de “Fdr”. 
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Figura22. Ventana de opciones de la herramienta Flow Direction 

 

III.3.3. Acumulación de flujo 

 

En este paso se determinan el número de celdas que llevan un proceso de drenaje a 

las demás celdas que lo rodean. Para esto se calcula un área de drenaje a partir de 

las celdas con capacidad de drenaje, dicha área es el cálculo del número de celdas 

con dicha capacidad por el área que presenta cada una de las celdas. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Flow Acumulation. Una vez hecho esto se abrirá una ventana, en ésta únicamente 

se tiene que corroborar que los datos sean los correctos, es decir que en la opción 

de “input flow direction grid” se encuentre el archivo de Fdr previamente elaborado y 

que en la opción de “output flow acumulation grid” se encuentre la carpeta de 

C:\puente\Layers\Fac y se le da clic en “OK”. Cuando el programa haya terminado de 

elaborar el proceso de relleno del terreno, aparecerá una ventana con el texto de 

“completed” a la que se le da clic en “close”, y nos mostrará una nueva capa con el 

nombre de “Fac”. 
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Figura 23. Ventana de opciones de la herramienta Flow Direction 

 

III.3.4. Definición de corriente 

 

En este paso el programa clasifica todas las celdas con flujo procedente de un 

número mayor de celdas a una entrada definida previamente por el usuario, 

relacionadas a la red de drenaje. La entrada puede especificarse como área en 

unidades del DEM o bien como número de celdas. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Stream Definition. Una vez hecho esto se abrirá una ventana, en ésta únicamente 

se tiene que corroborar que los datos sean los correctos, es decir que en la opción 

de “input flow acumulation grid” se encuentre el archivo de Fdr previamente 

elaborado, en la opción “area SqKm to define stram” se cambiará el valor por 2.7, ya 

que dicho valor es el más factible a usarse para llevar un análisis correcto y que en la 

opción de “output stream grid” se encuentre la carpeta de C:\puente\Layers\Str y se 

le da clic en “OK”. Cuando el programa haya terminado de elaborar el proceso de 

relleno del terreno, aparecerá una ventana con el texto de “completed” a la que se le 

da clic en “close”, y nos mostrará una nueva capa con el nombre de “Str”. 
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Figura 24. Ventana de opciones de la herramienta Stream Definition 

 

III.3.5. Segmentación de corriente 

 

Este paso divide los cauces que se encuentren en la zona de estudio en segmentos. 

Los segmentos divididos son tramos de cauces situados entre dos uniones de 

cauces que se encuentren sucesivamente, dichas uniones pueden ser una unión y la 

salida de la cuenca, o una unión y el límite de la cuenca. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Stream Segmentation. Una vez hecho esto se abrirá una ventana, en ésta 

únicamente se tiene que corroborar que los datos sean los correctos, es decir que en 

la opción de “input stream grid” se encuentre el archivo de Str previamente 

elaborado, en la opción “Input flow direction grid” se encuentre la capa Fdr, ya que 

dicho valor es el más factible a usarse para llevar un análisis correcto y que en la 

opción de “output stream link grid” se encuentre la carpeta de 

C:\puente\Layers\StrLnk y se le da clic en “OK”. Cuando el programa haya terminado 

de elaborar el proceso de relleno del terreno, aparecerá una ventana con el texto de 

“completed” a la que se le da clic en “close”, y nos mostrará una nueva capa con el 

nombre de “StrLnk”. 
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Figura 25. Ventana de opciones de la herramienta Stream Segmentation 

 

III.3.6. Delineación de los segmentos de captación 

 

En este paso únicamente como su nombre lo dice se delinean y delimitan los 

segmentos de la zona de estudio que fueron divididos en el paso anterior y tienen 

como función la captación del flujo. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Catchment Grid Delineation. Una vez hecho esto se abrirá una ventana, en ésta 

únicamente se tiene que corroborar que los datos sean los correctos, es decir que en 

la opción de “Input flow direction grid” se encuentre la capa Fdr, en la segunda 

opción “input link grid” se encuentre el archivo de StrLnk previamente elaborado, en 

la opción, ya que dicho valor es el más factible a usarse para llevar un análisis 

correcto y que en la opción de “output catchment grid” se encuentre la carpeta de 

C:\puente\Layers\Cat y se le da clic en “OK”. Cuando el programa haya terminado de 

elaborar el proceso de relleno del terreno, aparecerá una ventana con el texto de 

“completed” a la que se le da clic en “close”, y nos mostrará una nueva capa con el 

nombre de “Cat”. 
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Figura 26. Ventana de opciones de la herramienta Catchment Grid Delineation 

 

III.3.7. Procesamiento de polígonos de captación 

 

Este paso convierte las subcuencas o bien los segmentos de la cuenca de estudio 

elaborados en los pasos anteriores de formato grid a un formato vectorial, o bien a 

vectores. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Catchment Polygon Processing. Una vez hecho esto se abrirá una ventana, en ésta 

únicamente se tiene que corroborar que los datos sean los correctos, es decir que en 

la opción de “Input catchment grid” se encuentre la capa Cat, y que en la opción de 

“output catchment” se encuentre la carpeta de C:\ puente\ Proyecto.gdb\ Layers \ 

Catchment  y se le da clic en “OK”. Cuando el programa haya terminado de elaborar 

el proceso de relleno del terreno, aparecerá una ventana con el texto de “completed” 

a la que se le da clic en “close”, y nos mostrará una nueva capa con el nombre de 

“Catchment”. 
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Figura 27. Ventana de opciones de la herramienta Catchment Polygon Processing 

 

III.3.8. Procesamiento de la línea de drenaje 

 

Este paso convierte los cauces y líneas de drenaje de la cuenca de estudio, 

elaborados en los pasos anteriores de formato grid a un formato vectorial, o bien a 

vectores. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

> Drainage Line Processing. Una vez hecho esto se abrirá una ventana, en ésta 

únicamente se tiene que corroborar que los datos sean los correctos, es decir que en 

la opción de “Input stream link grid” se encuentre la capa StrLnk, en la segunda 

opción “Input Flow direction grid” se encuentre seleccionado la capa de Fdr y que en 

la opción de “output catchment” se encuentre la carpeta de C:\ puente\ Proyecto.gdb\ 

Layers \ DrainageLine  y se le da clic en “OK”. Cuando el programa haya terminado 

de elaborar el proceso de relleno del terreno, aparecerá una ventana con el texto de 

“completed” a la que se le da clic en “close”, y nos mostrará una nueva capa con el 

nombre de “DrainageLine”. 
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Figura 28. Ventana de opciones de la herramienta Drainaje Line Processing 

 

III.3.9. Procesamiento de zonas de captación adjuntas 

 

Este paso conjunta las subcuencas aguas arriba en cada unión con el arroyo. Esto  

es un paso necesario y se realiza para mejorar el rendimiento para subcuencas que 

delinean y para mejorar la extracción de datos al definir un proyecto en Hec-

.GeoHMS. 

 

En la barra de herramientas de HEC-GeoHMS se selecciona la opción Preprocessing 

>Adjoint Catchment Processing. Una vez hecho esto se abrirá una ventana, en ésta 

únicamente se tiene que corroborar que los datos sean los correctos, es decir que en 

la opción de “Input drainage line” se encuentre la capa DrainageLine, en la segunda 

opción “Input Catchment” se encuentre seleccionado la capa de Catchment y que en 

la opción de “output adjoint catchment” se encuentre la carpeta de C:\ puente\ 

Proyecto.gdb\ Layers \ AdjointCatchment  y se le da clic en “OK”. Cuando el 

programa haya terminado de elaborar el proceso de relleno del terreno, aparecerá 

una ventana con el texto de “completed” a la que se le da clic en “close”, y nos 

mostrará una nueva capa con el nombre de “AdjointCatchment”. 
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Figura29. Ventana de opciones de la herramienta Drainaje Line Processing 

 

III. 4. CONFIGURACIÓN DEL MODELO HIDROLÓGICO 

 

El menú “HMS Project Setup” se encarga de extraer la información necesaria de 

base de datos espacial y crear un proyecto HMS. Se trata de la especificación de 

puntos de control a la salida de la cuenca, los cuales definen los tributarios de la 

cuenca. 

 

Después de definir la salida de aguas abajo, HEC-GeoHMS extraerá los datos de las 

bases de datos creadas con las herramientas de preprocesamiento terreno para el 

área de drenaje aguas arriba de la toma de corriente. Entonces HEC-GeoHMS se 

puede utilizar para refinar la subcuenca y corriente a delineaciones, extraer las 

características físicas de las subcuencas y arroyos, los parámetros del modelo 

estimado, y preparar archivos de entrada para HEC-HMS. 

 

Dado que se pueden crear múltiples modelos de cuenca a partir de la misma base de 

datos espacial, estos modelos se gestionan a través de dos diferentes temas: uno de 

ellos son por pintos del proyecto “ProjPnts.shp” y el segundo el de área de proyecto 

“ProjArea.shp”. La gestión de estos modelos muestra las regiones ya incluidas en un 

proyecto. Además, dicha gestión permite la recreación de un área con diferentes  

entradas o borrar el proyecto y los ficheros relacionados. 
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Para definir un nuevo nombre de proyecto y crear un directorio que contendrá los 

datos extraídos y los archivos relacionados, vaya al HMSProject Setup Menu. El 

usuario ya debe tener localizada el área en la que la salida será definida antes de 

seleccionar estas opciones de menú. 

 

Para comenzar con este paso seleccionar Project Setup, de la barra de herramientas 

de HEC-GeoHMS, >Start New Project, de ahí se desplegará una ventana en la que 

se aceptan los nombres que el programa marca por default, “Poject Area” y “Project 

Points”  

 

 

 

Figura 30. Ventana de opciones de la herramienta Start New Project 

 

La capa de Project Area se utiliza para mostrar el área de drenaje de aguas arriba 

para el punto de salida y la capa de Project Point muestra la ubicación del punto de 

salida. 

 

Una vez aceptados los datos de la ventana anterior se abrirá una nueva ventana con 

el nombre de “Define New Project”, en la cual únicamente se introduce el nombre del 

proyecto, así como una descripción del mismo, y se dejan las demás opciones 

seleccionadas, y se le da clic en “OK”. Posteriormente se abrirá una nueva ventana 

en la que se menciona que el proyecto ha sido definido correctamente. 
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Figura31. Ventana definición del nuevo proyecto 

 

Previo al paso de comenzar a generar el proyecto es necesario seleccionar o tener 

ubicada la localización del punto de salida de la cuenca, con la ubicación de las 

coordenadas previamente mencionadas, para esto se debe de seguir los siguientes 

pasos. 

 

En la barra de herramientas de HEC-GeoHMS, se encuentra una herramienta con el 

icono de nombre “Add Project Points”, se le da clic en dicho icono, y en la parte de 

Map display, es decir donde se muestran las capas se ubicará el punto con las 

siguientes coordenadas. 

 

Tabla 4. Coordenadas del punto de salida de la cuenca platanillo 

 

X Y 

332, 284.98 1’ 936, 663.68 
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Figura32. Ubicación de la herramienta Add Project Points 

 

Al tener ubicado el cursos en las coordenadas se le da clic en ese punto, se abrirá 

una ventana de Poject Point en la cual se puede cambiar el nombre al punto de 

salida y su descripción, posteriormente se le da clic en “OK”, de esta manera ya se 

encontrará ubicado el punto de salida de la cuenca. 

 

 

 

Figura33. Ventana de opciones de la herramienta Add Project Points 

 

Con este paso se puede comenzar a generar el proyecto, en la barra de 

herramientas de HEC-GeoHMS, seleccionar la opción Project Setup>Generate New 

Project, de ahí se desplegará una ventana en la se muestran las diferentes capas 

que se crearán al generar el nuevo proyecto, se le da clic en “OK”. 



  
43 

 
  

 

 

Figura34. Ventana con las capas a crear con la generación del proyecto 

 

De aquí se desplegará una nueva ventana en la que se muestra que el programa se 

encuentra generando el proyecto, de ahí se abrirá una ventana donde el programa 

pregunta que si se quiere crear un proyecto para el área mostrada se le da clic en 

“Yes”, por último se desplegará una ventana en la que se menciona que el proyecto 

ha sido generado exitosamente. 

 

 

 

Figura35. Ventana para la creación del proyecto con el área de limitada 
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III. 5. CARACTERÍSTICAS DEL ARROYO Y DE LA SUBCUENCA 

 

La herramienta complementaria, HEC-GeoHMS, calcula varias características 

topográficas de los cauces y de las cuencas. Estas características son útiles para 

comparar cuencas entre sí y estimar parámetros hidrológicos. Las características 

físicas de la cuenca y los cauces se almacenan en las tablas de atributos, creadas 

por el programa, las cuales pueden ser exportadas para ser usada en hojas de 

cálculo y algunos otros programas. 

 

III.5.1. Longitud del cauce 

 

Esta operación calcula la longitud de los cauces de todas las subcuencas los cauces 

de propagación contenidos en la capa “River.shp”. Las longitudes calculadas se 

agregan a la tabla de atributos. En esta tabla ya existe una longitud calculada con los 

datos del fichero Raster. Esta operación lo hace a partir del fichero de la capa que se 

elaboró en formato vectorial. 

 

En la barra de herramientas de HEC-GeoHMS, seleccionar la opción Characteristics 

> River Lenght, de ahí se desplegará una ventana en la que nos muestra la opción 

de la capa que se va a utilizar para determinar dicha longitud, permanece la capa 

que selecciona el programa inicial, dicha capa es la que se desarrolla al generar el 

proyecto, para el caso de estudio la capa es  “River 28”, se le da clic en “OK”. Si se 

desarrollan los pasos correctamente el programa desplegará una nueva ventana en 

la que se informa que el proceso se llevó exitosamente. 
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Figura36. Ventana de opciones de la herramienta River Length 

 

Para revisar el resultado de este proceso, se revisa la tabla de atributos, en la capa 

mostrada en la tabla de contenidos “River28”, se da clic en dicha capa con el botón 

derecho y se selecciona la opción “Open Attribute Table”, de esta manera se abrirá 

una ventana con la tabla de atributos en donde se mostrará una columna con las 

longitudes de los cauces. 

 

III.5.2. Pendiente del cauce 

 

En esta operación el programa extrae las cotas de aguas arriba, así como también 

las cotas de aguas debajo de todos los cauces de la subcuenca, y con estos datos 

calcula la pendiente media de todas las cotas extraídas de los cauces de la 

subcuenca. 

 

Para esto en la barra de herramientas de HEC-GeoHMS, seleccionar la opción 

Characteristics > River Slope, de ahí se desplegará una ventana en la que nos 

muestra la opción de la capa que se va a utilizar para determinar dicha longitud, 

“Input Raw DEM”, permanece la capa que selecciona el programa inicial, dicha capa 

es la que se desarrolla al generar el proyecto, para el caso de estudio la capa es  

“Raw DEM”, igualmente para le segunda opción “Input River” permanece la capa 

inicial de “River 28”,  se le da clic en “OK”. Si se desarrollan los pasos correctamente 
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el programa desplegará una nueva ventana en la que se informa que el proceso se 

llevó exitosamente. 

 

 

Figura37. Ventana de opciones de la herramienta River Slope 

 

III.5.3. Pendiente de la cuenca 

 

En este proceso el programa extrae las cotas de la cuenca y determinar la pendiente 

media de la misma, este proceso es necesario, ya que el programa lo usa para la 

determinación del parámetro del tiempo de retraso. 

 

Para poder obtener esta característica es necesario elaborar previamente una capa  

con la rugosidad del cauce, para este paso se le da clic en el botón “Arc ToolBox 

Window” en la barra de herramientas, de esta manera se abrirá una ventana de 

herramientas diferente, seleccionamos Spatial Analyst Tools > Surface > Slope. 
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Figura 38. Ventana con la herramienta Slope del Arc ToolBox Window 

 

De ahí el programa abrirá una nueva ventana, en la opción de “Input Raster” se 

selecciona la capa de RawDEM, en la parte de “Output Raster” se selecciona la 

carpeta creada y la dirección del proyecto, para el ejemplo elabora se busca la 

siguiente dirección c:\Puente\PROYECTO.GDB, y en la parte de “Name”, se elige el 

nombre para el caso es el nombre de “Slope”, en la tercera opción que es la de 

“Output measurement” se elige la opción de ¨PERCENT RISE” y en la última opción 

de Z FACTOR, se deja el valor inicial de 1, se le da clic en “OK”. Al terminar de crear 

la capa, se desplegará una ventana donde se avisa que la capa se ha creado 

exitosamente. 

 

 

Figura39. Ventana de opciones de la herramienta Slope 
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Figura40. Ventana del Output Raster 

 

Para continuar con el proceso es necesario adicionar la capa en caso de que el 

programa no la adicione al proyecto automáticamente, para esto se utiliza el botón 

Add Data, al que se accede también desde el menú de la barra de herramientas 

standard: File>Add data y desde el menú contextual del Data frame. Se busca la 

capa de Slope dentro del archivo de nombre “PROYECTO.GDB”. 

 

Una vez terminada de crear la capa de Slope, y de haber cargado dicha capa al 

proyecto, ahora sí se puede continuar con la determinación de la pendiente del 

cauce, para esto en la barra de herramientas de HEC-GeoHMS, seleccionar la 

opción Characteristics >Basin Slope, de ahí se desplegará una ventana en la que nos 

muestra la opción de la capa que se va a utilizar para determinar dicha longitud, 

“Input Slope Grid”, en esta opción es necesario seleccionar la capa en formato Grid 

que se creó en el paso previo, para el caso de estudio la capa es  “Slope”, para le 

segunda opción “Input Subbasin” permanece la capa inicial de “Subbasin 28”,  se le 

da clic en “OK”. Si se desarrollan los pasos correctamente el programa desplegará 

una nueva ventana en la que se informa que el proceso se llevó exitosamente. 
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Figura41. Ventana de opciones de la herramienta Basin Slope 

 

 

III.5.4. Camino más largo del flujo 

 

La herramienta de la trayectoria de flujo más larga calcula un número de 

características físicas: la trayectoria de flujo más larga, la elevación de aguas arriba, 

la elevación aguas abajo, y la pendiente entre los puntos finales. Estas 

características se almacenan en la capa de trayectoria de flujo más larga. 

 

Para esto en la barra de herramientas de HEC-GeoHMS, seleccionar la opción 

Characteristics > Longest Flow Path, de ahí se desplegará una ventana en la que nos 

muestra la opción de la capa que se va a utilizar para determinar dicha longitud, 

“Input Raw DEM”, en esta opción se dejará la capa que tiene inicialmente que se 

creó al generar el proyecto, para el caso de estudio la capa es  “Raw DEM”, para le 

segunda opción “Input Elevation Grid”, se deja la capa que tiene al inicio con el 

nombre de “Fdr”, en la tercera opción “Input Subbasin”, se deja la capa que tiene al 

inicio con el nombre de “Subbasin28” , por último en la cuarta opción, “Output 

Longest Flow Path” se deja la dirección con la carpeta de puente, para el caso 

estudiado es C:\Punte\proplata\proplata.gdb\proplata\longestFlowpath28 se le da clic 

en “OK”. Si se desarrollan los pasos correctamente el programa desplegará una 

nueva ventana en la que se informa que el proceso se llevó exitosamente. 
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Figura42. Ventana de opciones de la herramienta Longest Flowpath 

 

III.5.5. Centroide de la cuenca 

 

La herramienta para determinar el centroide cuenca identificará el centro de 

gravedad de cada subcuenca. La función será realizada en el conjunto seleccionado 

de la subcuenca o de todas las subcuencas. La ubicación centroide cuenca puede 

ser estimado de cuatro maneras. Tres métodos pueden ser utilizados para definir el 

centroide, cada uno usando un algoritmo diferente y por lo tanto proporcionar un 

resultado diferente. La calidad del resultado es una función de la forma de la 

subcuenca y debe ser evaluado después de que se generan. Algunas veces el centro 

de gravedad se encuentra en el límite subcuenca y por lo tanto deben ser movidos o 

un método diferente debe ser utilizado. 

 

Para esto en la barra de herramientas de HEC-GeoHMS, seleccionar la opción 

Characteristics > Basin Centroid de ahí se desplegará una ventana en la que nos 

muestra la opción de la capa que se va a utilizar para determinar dicha longitud, 

“Select Centroid Method”, en esta opción se dejará el método que tiene inicialmente, 

para el caso de estudio el método seleccionado  “Center of gravity”, para le segunda 

opción “Input Subbasin”, se deja la capa que tiene al inicio con el nombre de 

“Subbasin28” , por último en la cuarta opción, “Output Centroid” se deja la dirección 

con la carpeta de puente, para el caso estudiado es 
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C:\Punte\proplata\proplata.gdb\proplata\Centroid28 se le da clic en “OK”. Si se 

desarrollan los pasos correctamente el programa desplegará una nueva ventana en 

la que se informa que el proceso se llevó exitosamente. 

 

 

 

Figura43.- Ventana de opciones de la herramienta Basin Centroid 

 

III.5.6. Elevación del centroide 

 

En esta operación el programa calcula la elevación para cada punto donde se ubicó 

el centroide de la cuenca, para este proceso es necesario un DEM. Los datos de las 

elevaciones calculadas son almacenados en la tabla de atributos de la capa de 

centroides. 

 

Para esto en la barra de herramientas de HEC-GeoHMS, seleccionar la opción 

Characteristics > Centroid Elevation de ahí se desplegará una ventana en la que nos 

muestra la opción de la capa que se va a utilizar para determinar dicha longitud, 

“Input Raw DEM”, en esta opción se dejará la capa que tiene inicialmente, para el 

caso de estudio la capa seleccionado  “Raw DEM”, para le segunda opción “Input 

Centroid”, se deja la capa que tiene al inicio con el nombre de “Centroid28” , se le da 

clic en “OK”. Si se desarrollan los pasos correctamente el programa desplegará una 

nueva ventana en la que se informa que el proceso se llevó exitosamente. 
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Figura44. Ventana de opciones de la herramienta Centroid Elevation 

 

III.5.7. Trayectoria del flujo más largo desde el centroide 

 

Esta operación calcula la trayectoria de flujo centroidal proyectando el centroide en la 

trayectoria de flujo más larga. La trayectoria de flujo centroidal se mide desde el 

punto proyectado sobre la trayectoria de flujo más larga a la salida subcuenca. 

 

Para esto en la barra de herramientas de HEC-GeoHMS, seleccionar la opción 

Characteristics > Centroidal Longest Flowpath de ahí se desplegará una ventana en 

la que nos muestra la opción de la capa que se va a utilizar para determinar dicha 

longitud, “Input Subbasin”, en esta opción se dejará la capa que tiene inicialmente, 

para el caso de estudio la capa seleccionado  “Subbasin28”, para le segunda opción 

“Input Centroid”, se deja la capa que tiene al inicio con el nombre de “Centroid28”,  

para la opción de “Input Longest Flowpath” se deja la selección que viene al inicio 

“LongestFlowPath28”, para la última opción “Output Centroidal Longest Flow Path” se 

deja la dirección de la carpeta, para el caso estudiado es la siguiente C:\Puente 

\proplata\proplata.gdb\proplata\CentroidalLongestFlowPath28 se le da clic en “OK”. 

Si se desarrollan los pasos correctamente el programa desplegará una nueva 

ventana en la que se informa que el proceso se llevó exitosamente. 
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Figura45. Ventana de opciones de la herramienta Centroid Longest Flowpath 

 

Con este proceso se termina de obtener y calcular las características del arroyo y de 

la subcuenca. El siguiente paso es delimitar la zona de la subcuenca en los MDE de 

los usos y tipos de suelo, ya que dicho modelo se encuentra el mapa de la República 

completo. Para esto se siguen los siguientes pasos. 

 

III.5.8. Delimitación del polígono del MDE de usos y tipos de suelo 

 

Se cierra el proyecto que se ha elaborado, después de haber guardado los pasos y 

procesos que se han elaborado, se abre un nuevo mapa. 

 

En el nuevo mapa abierto se cargara el MDE de uso y tipo de suelo. Para esto se 

utiliza el botón Add Data, al que se accede también desde el menú de la barra de 

herramientas standard: File>Add data y desde el menú contextual del Data frame. Se 

busca la carpeta donde se tenga guardado el MDE con el uso y tipo de suelo, para el 

proyecto elaborado dicho modelo se guardo en una subcarpeta de la carpeta 

“Puente” >Insumos > Uso suelo vegetación edafológica> uso de suelo y vegetación 

>uso_del_suelo_veg_250_serie_iv_v.shp. 
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Figura46. Ventana de Add Data (agregar la capa de uso de suelo) 

 

Una vez que ese modelo se tenga cargado se agregará la capa de “ProjectArea”. 

Para esto se utiliza el botón Add Data, al que se accede también desde el menú de la 

barra de herramientas standard: File>Add. “Puente” > PROYECTO.GDB > Layers > 

ProjectArea. 

 

 

 

Figura47. Ventana de Add Data (agregar la capa de ProjectArea) 

 

En la tabla de contenido en la capa de “ProjectArea” se le da clic con el botón 

derecho > Zoom tol ayer, para que la vista acerque la vista al área de proyecto. 

 

Ahora se recortará el MDE del uso y tipo de suelo, para obtener únicamente un 

polígono de la zona de la cuenca. Para esto se da clic en la pestaña de 

Geoprocessing en la barra de herramientas > Clip. Con esto el programa desplegará 
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una ventana,  en “Input Features” se selecciona 

“uso_del_suelo_veg_250_serie_iv_v.shp”  en “Clip Features” se selecciona  

“ProjectArea”, en “Output Feature Class” se coloca la dirección de PROYECTO.GDB 

en la carpeta puente, y se le pone el nombre de “usosuelo”, la siguiente dirección 

C:\puente\POYECTO.GDB\usosuelo. Se le da clic en “OK” una vez terminado. 

Cuando el programa termina de recortar el MDE y crear una nueva capa aparece una 

ventana donde se informa que se completo el proceso. 

 

 

 

Figura48. Ventana de opciones de la herramienta Clip 

 

El mismo proceso se lleva a cabo para el modelo edafológico de la zona, para 

complementar la información de tipo de suelo de la zona. 

 

Se abre un nuevo mapa. En el nuevo mapa abierto se cargara el MDE de uso y tipo 

de suelo. Para esto se utiliza el botón Add Data, al que se accede también desde el 

menú de la barra de herramientas standard: File>Add data y desde el menú 

contextual del Data frame. Se busca la carpeta donde se tenga guardado el MDE con 

el modelo edafológico, para el proyecto elaborado dicho modelo se guardó en una 

subcarpeta de la carpeta “Puente” >Insumos > Uso suelo vegetación edafológica> 

edafolo >eda251mgw.shp. 
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Una vez que ese modelo se tenga cargado se agregará la capa de “ProjectArea”. 

Para esto se utiliza el botón Add Data, al que se accede también desde el menú de la 

barra de herramientas standard: File>Add. “Puente” > PROYECTO.GDB > Layers > 

ProjectArea. 

 

En la tabla de contenido en la capa de “ProjectArea” se le da clic con el botón 

derecho > Zoom tol ayer, para que la vista acerque la vista al área de proyecto. 

 

Ahora se recortará el MDE del uso y tipo de suelo, para obtener únicamente un 

polígono de la zona de la cuenca. Para esto se da clic en la pestaña de 

Geoprocessing en la barra de herramientas > Clip. Con esto el programa desplegará 

una ventana,  en “Input Features” se selecciona “eda251mgw.shp”  en “Clip 

Features” se selecciona  “ProjectArea”, en “Output Feature Class” se coloca la 

dirección de PROYECTO.GDB en la carpeta puente, y se le pone el nombre de 

“edafo”, la siguiente dirección C:\puente\POYECTO.GDB\edafo. Se le da clic en “OK” 

una vez terminado. Cuando el programa termina de recortar el MDE y crear una 

nueva capa aparece una ventana donde se informa que se completó el proceso. 

 

Una vez que se crearon las dos capas de uso de suelo y edafológico, es necesario 

que se unan, para que la información que contienen se complemente, para esto se 

siguen los siguientes pasos. 

 

Se abre un nuevo mapa, se cargan las capas nuevas, la de uso de suelo y la 

edafológica, Para esto se utiliza el botón Add Data, al que se accede también desde 

el menú de la barra de herramientas standard: File >Add. “Puente” > 

PROYECTO.GDB > usosuelo. File>Add. “Puente” > PROYECTO.GDB > edafo. Al 

cargar la capa “usosuelo”, aparecerá una ventana en la que se menciona que dicha 

capa se encuentra en un sistema de coordenadas diferente, se le da clic en “close”. 
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Figura49. Ventana de Add Data (agregar la capa de usosuelo) 

 

 

 

Figura50. Mensaje de sistema de coordenadas diferente en la capa usosuelo 

 

 

 

Figura51. Ventana de Add Data (agregar la capa de edafo) 
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Ahora se une el MDE del uso y tipo de suelo con el edafológico para obtener 

únicamente un polígono de la zona de la cuenca. Para esto se da clic en la pestaña 

de Geoprocessing en la barra de herramientas > Union. Con esto el programa 

desplegará una ventana,  en “Input Features” se selecciona “edafo”, después en esa 

misma opción se selecciona “usosuelo”, en “Output Feature Class” se coloca la 

dirección de PROYECTO.GDB en la carpeta puente, y se le pone el nombre de 

“ncurva”, la siguiente dirección C:\puente\POYECTO.GDB\ncurva. Se le da clic en 

“OK” una vez terminado. Cuando el programa termina de recortar el MDE y crear una 

nueva capa aparece una ventana donde se informa que se completo el proceso. 

 

 

 

Figura52. Ventana de opciones de la herramienta unión 

 

Se abre un nuevo mapa, se cargan la capa nueva, la “ncurva”, Para esto se utiliza el 

botón Add Data, al que se accede también desde el menú de la barra de 

herramientas standard: File >Add. “Puente” > PROYECTO.GDB > ncurva. 

 

En la tabla de contenidos se busca la capa, se da clic derecho en la capa y se 

selecciona “Open Attribute Table”, se abrirá una ventana que muestra las 

características de la capa, se agregaran nuevas columnas, en el icono de “Table 

options” de la barra de herramientas de la ventana de la tabla >Add Field. 
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Figura53. Opción para abrir la tabla de atributos 

 

 

 

Figura54. Ubicación de la herramienta Add Field 

 

 

 

Figura55. Ventana de opciones de la herramienta Add Field 
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Para la primera columna en Name: “TiposueH” > Type: “Text” >Length : “5”.  Para la 

segunda columna en Name: “PctA” > Type: “Double”. Para la tercera columna en 

Name: “PctB” > Type: “Double”. Para la cuarta columna en Name: “PctC” > Type: 

“Double”. Para la quinta columna en Name: “PctD” > Type: “Double”. Para la sexta 

columna en Name: “Land use” > Type: “Double”. 

 

Para el llenado de las primeras cinco columnas se utiliza la información de la 

columna “Descripcio”, para la primera columna “TiposueH”, en las filas que sean 

andosol se coloca la letra “A” y para las filas que sean Acrisol la letra “D”, para la 

segunda columna en las filas que tengan la letra “A” se coloca el número “100” y para 

las demás filas “0”, para la tercera y cuarta columna se coloca “0”, ya que no hay de 

ese tipo de suelo dentro de la zona de estudio, para la quinta columna en las filas 

con “D” se coloca “100” y para las demás filas “0”. Por último en la columna de “Land 

use” se usa la información de la columna “Tipo_Ecov” dicha columna se ordena en 

orden descendente y se enumeran los diferentes tipos de suelo del 1 al 4. 

 

Para poder editar las columnas se da clic en la barra de herramientas “Editor” > Start 

Editing, y de esta manera se puede comenzar a introducir los valores, cuando se 

termina de editar la tabla se da clic en la barra de herramientas “Editor” > Save 

Editing, y por ultimo para dejar de editar la tabla, se da clic en la barra de 

herramientas “Editor” > Stop Editing 

 

 

 

Figura56. Ubicación de las herramientas de edición de tablas 
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 De esta manera la tabla queda de la siguiente manera: 

 

Tabla 5. Contenido modificado de la capa “ncurva” 

 

 

 

III.5.9. Parámetros hidrológicos 

 

Se cierra la capa del nuevo modelo con la tabla de tipo de suelo. Se abre el proyecto 

que se generó en los pasos anteriores, para continuar con la modelación del mismo, 

en la parte derecha de la ventana del programa, hay una barra que es la barra de 

catálogos, en esta se da clic para desplegarla, se busca Home-Puente > 

PROYECTO.GDB. Se da clic con el botón derecho, para abrir una nueva ventana 

New > Table. Esto para agregar una nueva tabla de propiedades, se abre una nueva 

ventana, en la parte de Name: “CNLookUp”, clic en siguiente, de nuevo se da clic en 

el botón de siguiente, respetando los valores seleccionados inicialmente, y por 

últimos se da clic en el botón de “Finish”. 
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Figura57. Pasos para crear una nueva tabla 

 

En la tabla de contenidos se busca la tabla creada, se da clic con el botón derecho y 

se selecciona “Open Attribute Table”, se modifica la tabla ya que no contiene ningún 

dato, los pasos para la modificación de la tabla son los mismos ya descritos. En esta 

tabla únicamente se tendrán 6 columnas. 

 

Para la primera columna en Name: “LUValue” > Type: “ShortText”.  Para la segunda 

columna en Name: “Description” > Type: “Text”. Para la tercera columna en Name: 

“A” > Type: “Short Text”. Para la cuarta columna en Name: “B” > Type: “Short Text”. 

Para la quinta columna en Name: “C” > Type: “Short Text”. Para la sexta columna en 

Name: “D” > Type: “Short Text”. 

 

El llenado de las filas debe ser como se muestra en la siguiente imagen: 

 

Tabla 6. Contenido de la tabla “CNLookUp” 
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En la barra de herramientas de HEC-GeoHMS, se da clic en Utility >  Generate CN 

Grid, se abrirá una nueva ventana, en “Input Hydro Dem” se selecciona la opción de 

RawDEM, en la segunda opción “Input Soil Landuse Polygon” se selecciona la capa 

de “ncurva”, en la siguiente opción “Input CurveNumber Lookup” se selecciona la 

tabla “CNLookUp”, y en la última opción “ Output Curve Number Grid” se busca la 

carpeta de puente > proplata y se le pone el nombre de CNGrid, quedando la 

siguiente dirección en la opción “C:\puente 1\proplata\CNGrid”. Se da clic en “OK”. 

 

 

 

Figura58. Ventana de opciones de la herramienta Generate CN Grid 

 

Una vez terminados estos pasos se inicia con la determinación de los parámetros del 

modelo, para esto en la barra de herramientas de HEC-GeoHMS, se da clic en 

Parameter > Select HMS Processes. Se abrirá una ventana, en las primeras 

opciones se respetan las capas que vienen al inicio, en “Subbasin-Loss Method” se 

selecciona la opción “SCS”, en “Subbasin-Transform Method” se selecciona la opción 

“SCS”, en “Subbasin-Baseflow Method” se elige la opción “None”, y en “River-Route 

Method” se pone “Muskingum”. Se da clic en “OK”. 
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Figura59. Ventana de opciones de la herramienta Select HMS Processes 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en Parameter > River 

Autoname. Se abrirá una ventana, se respeta la opción que nos marca inicialmente 

“River28”. Se da clic en “OK”. 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en Parameter > Basin 

Autoname. Se abrirá una ventana, se respeta la opción que nos marca inicialmente 

“Subbasin28”. Se da clic en “OK”. 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en Parameter > Subbasin 

Parameters from Raster. Se abrirá una ventana, en la primera opción se respeta la 

opción que nos marca inicialmente “Subbasin28”, en la última opción “Input Curve 

Number Grid” se selecciona “CNGrid”, mientras que las demás opciones se dejan en 

blanco. Se da clic en “OK”. 
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Figura60. Ventana de opciones de la herramienta Subbasin Parameter 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en Parameter > CN Lag. El 

programa procesará la opción y al finalizar aparece una ventana donde se informa 

que el proceso se completó. 

 

III. 6. CARACTERÍSTICAS DEL MODELO PARA LA EXPORTACIÓN 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en HMS >Map to HMS Unit. 

Se abrirá una ventana, se cambia la opción que nos marca inicialmente “English” a 

“SI”. Se da clic en “OK”. 

 

 

 

Figura61. Ventana de selección del tipo de unidades 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en HMS >Check Data. Se 

abrirá una ventana donde se informa que el proceso terminó. Se da clic en “Yes”. 
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En la barra de herramientas de HEC-GeoHMS, se da clic en HMS > HMS Schematic. 

Se abrirá una ventana, se respetan las opciones que nos marca inicialmente. Se da 

clic en “OK”. Y se abre una ventana donde se informa que el proceso terminó. 

 

 

 

Figura62. Ventana de opciones de HMS Schematic 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en HMS > Toogle Legend > 

HMS Legend. 

 

 

 

Figura63. Ubicación de la herramienta HMS Legend 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en HMS >Add Coordinated. 

Se abrirá una ventana donde se informa que no hay una referencia espacial para las 

coordenadas “Z” se le da clic en “OK”. Por último muestra una ventana con la 

información de que el proceso terminó correctamente, se da clic en “OK”. 
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En la barra de herramientas de HEC-GeoHMS, se da clic en HMS >Prepare Data for 

Model Export. Se abrirá una ventana, se respetan las opciones que nos marca 

inicialmente. Se da clic en “OK”. Y se abre una ventana donde se informa que el 

proceso terminó. 

 

 

 

Figura64. Ventana de opciones de Prepare Data for Model Export 

 

En la barra de herramientas de HEC-GeoHMS, se da clic en HMS > Background 

Shape File. Se abrirá una ventana, se respetan las opciones que nos marca 

inicialmente. Se da clic en “OK”. Y se abre una ventana donde se informa que el 

proceso terminó. 

 

 

 

Figura65. Ventana de opciones de Bakground Shape File 

 

El último paso es exportar el modelo elaborado a diferentes tipos de archivos para 

utilizar en el programa HEC-HMS. En la barra de herramientas de HEC-GeoHMS, se 

da clic en HMS > Basin Model File. 

IV. RESULTADOS  
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A continuación se muestran los parámetros obtenidos con ayuda del software antes 

descrito, se muestra una imagen con la división de la cuenca en las respectivas 

subcuencas, con los ríos o cauces correspondientes. Después de la imagen se 

muestra una tabla con los datos obtenidos. 

 

 

 

Figura 66. Mapa con la división de las subcuencas creadas 

 

Tabla 7. Parámetros obtenidos de las subcuencas 

 

Subcuenca Área (km2) Número de curva (NC) Tiempo de retraso (min) 

W 100 11.2412 70.6094 1027.4 

W 90 6.2289 38.741 1684.1 

W 80  1.4731 57.321 330.33 

W 70 5.3374 44.823 1315.1 

W 60 15.353 44.641 2037.9 

A continuación se muestra una comprobación de los parámetros que se obtienen con 

el software, calculándolos mediante las formulas establecidas en la literatura 

existente. Subcuenca W100: 
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0.60L cT T
   (4.1)

 

El tiempo de retraso, LT
, es el tiempo medido entre el llamado centro de masa de la 

precipitación efectiva y el pico del hidrograma de escurrimiento: 

 

0.7
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1000
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c
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T

Y   
(4.2)

    
 

 

Donde  es la distancia desde el punto más alejado hasta la salida de la cuenca, en 

m; CN  es el número de curva de escurrimiento, función del tipo y cobertura del 

suelo,  Y es la pendiente promedio de la cuenca, expresada en forma de porcentaje. 

Con ayuda del software Excel se calcula primero el tiempo de concentración, para 

posteriormente calcular el tiempo de retraso. 

 

Tabla 8. Resultados obtenidos con la aplicación de fórmulas 

 

CN= 70.609375    

L= 6467.422074    

Y = 0.078721    

TC = 28.54717695    

TL= 17.12830617 horas 1027.69837 min 

 

Los valores de Y fue obtenido de la tabla de atributos de Subbasin30, mientras que el 

valor de L de la tabla de atributos de LongestFlowPath 30. 

 

 

Figura 67. Tablas con los datos requeridos para los cálculos 
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V. CONCLUSIONES 

 

Los estudios hidrológicos apoyados en las herramientas informáticas actuales 

brindan muchas posibilidades, entre las que se pueden citar la visualización y el 

análisis de los datos, además de que se reduce notablemente el tiempo en la 

modelación. La modelación hidrológica de las cuencas hidrográficas permite realizar 

pronósticos de las posibles afectaciones de una zona debido a la ocurrencia de 

lluvias extremas máximas, es por ello que estudios de este tipo son de suma 

importancia y se ven complementados con herramientas informáticas de última 

generación como son los casos de los SIG y de los modelos de simulación 

hidrológica como el software Hec-HMS por ejemplo. 

 

El uso de sistemas de información geográfica (SIG) en el geoprocesamiento de la 

información disponible de la cuenca, permite definir con relativa facilidad las 

características geomorfológicas y algunos valores previos de varios de los 

parámetros incluidos en los principales modelos hidrológicos disponibles en HEC-

HMS. Así mismo, utilizando modelos de elevación digital, se pueden determinar las 

condiciones geométricas que definen las características del flujo en canales 

naturales y/o artificiales y las zonas de inundación aledañas a estos. Antes de contar 

con estas herramientas computacionales, todos los datos se debían de calcular de 

manera manual con las fórmulas que se contaban, lo cual se complicaba la 

modelación y su elaboración era más tardía, además con los modelos digitales con 

los que se cuentan actualmente no es necesario tener que ir a la zona de estudio 

para elaborar estudios de campo, ya que dichos modelos cuentan con estos datos, 

además de que algunas veces por cuestiones de tiempo es necesario contar con los 

datos de manera urgente y no es posible llevar a cabo un estudio de campo y con 

estos modelos se recaba dicha información. 

 

La ayuda de estas herramientas facilita la elaboración de modelos de gran magnitud 

ya que pueden obtener los cálculos de los parámetros, sin que resulte tan laborioso 

como era el calcularlos de manera manual. 
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